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BLDC Ceiling Fan Controller with Sensor-less Sinusoidal
Current Control, TIDA-00386

This reference design provides complete solution for 3-phase BLDC, ceiling fan applications. The solution consists of three
sections:

1. AC-DC section: designed to work with universal main AC input range i.e. 90Vac-265Vac. It uses fly back ac/dc
topology, to generate 24V DC input power from main AC. It is based on UCC28630 primary side PWM regulator.

2. Motor control section: It based on DRV10983, single chip IC operates at 24Vdc. This IC integrates all basic building
blocks of 3-phase BLDC motor control i.e. sinusoidal sensor-less motion control engine + 3-phase H-bridge inverter
including pre-drivers. It also provides 3.3V regulated output to support external loads up-to 100mA.

3. IR remote based Speed control section: based on value-line MSP430G2201, which decodes the remote inputs and
generate PWM duty cycle command for fan speed control.
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Figure 1: Functional block diagram of BLDC ceiling fan controller

Measuring Equipment used for Testing:

1. Voltech single phase power analyzer PM100 for AC power measurement at input
2.  Fluke digital Multi-meters for DC power measurement at 24Volt
3. Tektronix Digital Oscilloscope DP0O4034 for waveform capture

Loading Equipment: 24V/16-pole 3-phase BLDC ceiling fan motor is utilize for testing. Motor is able to reach 310 rpm at
90% duty at 24Vdc input with power consumption of 40Watt at DC.
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Motor Speed Control Firmware: A remote based on NEC IR transmission protocol runs at carrier frequency of 38 kHz is
used for speed control. Firmware is developed for MSP430G2201 to provide 5-step PWM duty cycle commands to DRV10983
with following features:

PWM duty cycle command is generated at 1.5 kHz and provides 10% step change in duty cycle.

Each time increment key is pressed duty-cycle is increased by 10%, similarly for decrement key duty-cycle is
reduced by 10%. Maximum duty cycle is 90% and minimum duty cycle is kept at 50%.

The firmware can be used with any IR remote that supports NEC IR transmission protocol, by changing key-codes in
software. Please refer to appendix-A for more details.

Test Results:

1. AC-DC characterization test: Test is performed to characterize AC/DC converter at different load (motor speed)
and input AC line condition. Table below shows the data for AC/DC input power, output power at 24V and most
importantly efficiency and output voltage regulation, as shown in figure 2, 3 and 4 respectively. From these figures it
can be concluded that AC/DC efficiency is above 88% and output voltage remains with limits of 23.75V to 24.25 at all
load and line conditions to achieve speed regulation within +/1%. .
AC Voltage Ac current AC Power DC Voltage DC Current DC Power AC/DC Motor Speed
(Volt) (Amp) (Watt) (Volt) (amp) (Watt) efficiency (rpm)
(%)
0.24 09.87 23.80 0.37 08.81 89.21 17 step ~190 rpm
0.36 15.72 23.86 0.59 14.08 89.55 2% step ~220 rpm
90 0.52 23.85 23.89 0.90 21.50 90.15 3"step ~250 rpm
0.71 33.40 23.90 1.25 29.87 89.44 4" step ~280 rpm
0.95 45.90 23.91 1.71 40.88 88.55 5" Step ~310 rpm
0.19 09.85 23.80 0.37 08.81 89.41 1% step ~190 rpm
0.29 15.65 23.86 0.59 14.08 89.55 2" step ~220 rpm
115 0.42 23.71 23.89 0.90 21.50 90.68 3"%tep ~250 rpm
0.57 33.2 23.90 1.25 29.87 89.98 4™ step ~280 rpm
0.74 45.3 23.93 1.70 40.68 89.80 5" Step ~310 rpm
0.13 09.73 23.77 0.37 08.67 89.13 1" step ~190 rpm
0.20 15.50 23.83 0.58 13.82 89.17 2% step ~220 rpm
230 0.28 23.65 23.89 0.90 21.50 90.91 3"step ~250 rpm
0.38 32.80 23.90 1.25 29.87 91.00 4™ step ~280 rpm
0.48 44.90 2391 1.70 40.65 90.52 5" Step ~310 rpm
0.11 09.77 23.77 0.37 08.67 88.76 17 step ~190 rpm
0.17 15.52 23.81 0.58 13.81 88.98 2 step ~220 rpm
265 0.25 23.70 23.88 0.90 21.50 90.68 3"step ~250 rpm
0.33 32.85 23.90 1.25 29.87 90.94 4" step ~280 rpm
0.43 44.95 23.90 1.70 40.63 90.38 5" Step ~310 rpm
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Figure2: AC/DC efficiency with respect to motor load at nominal voltages

=—#—90Vac

==265Vac

180.00 220.00 250.00 280.00 210.00

Motor Speed (rpm)

Figure3: AC/DC efficiency with respect to motor load at Min& Max voltage
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Figure4: 24VDC output regulation with respect to motor load

2. Motor phase voltage and current waveforms: Figure 5 and 6 shows the three-phase voltages applied voltages
with respect to GND and current flowing through one phase of motor at full speed, 310 rpm. Figure 5 shows the
actual PWM voltages waveform applied to motor whereas figure 6 shows the filtered voltage waveforms. Figure 6
demonstrate sinusoidal PWM with third-harmonic addition, as explained in DRV10983 data-sheet. The third harmonic
content in phase to ground voltage get cancelled across phase to phase voltage and produce sinusoidal current in
motor phase, as evident in both figure 5 and 6.
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Figure5: Motor phase voltages & current at 310 rpm
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Figure6: Filtered Motor phase voltages & current at 310 rpm
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3. Start-up time: Figure 7 and 8 below shows the motor start-up time at different line condition. The maximum start-up
time occurs at low line condition i.e. at 90Vac and it in range of 1.3 seconds, whereas at 230Vac it is in range of
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4. Ripple voltage at 24Vdc: One of primary goal of this reference design is to minimize power frequency ripple (100 Hz
or 120Hz) in 24Vdc. This provides efficient utilization of sinusoidal control of DRV10983 to avoid low frequency noise
and achieves best in class acoustic performance. The figures 9 and 10 capture ripple voltage and max ripple voltage
is in range of 160mVpk-pk i.e. 0.6% of 24Vdc.
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Figure9: 24Vdc ripple voltage at 90Vac & 310 rpm
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5. Thermal Image of test board: Figures 11 and 12 shows thermal image of top and bottom of test board at 25°
Celsius ambient during 45watt input power. The maximum temperature rise of ~55° Celsius is observed at
DRV10983 case and snubber-diodes (D8/D9).

Top View @ 45Wattinput

Figurell: PCB top side thermal image at 230Vac/ 45Watt input power

Snubber diodes
80degC

DRV10983 at

80degC
Bottom View @ 45Watt input

Figure12: PCB bottom thermal image at 230Vac/ 45Watt input power
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Appendix-A

Instruction to change the IR (infra-red) remote key codes for speed control

Important Downloads:

1. The firmware for this design is developed for MSP430G2201 using Texas’s Instrument IDE- Code composer Studio
version 5.5.0 (CCS), therefore as first step user must have CCS version 5.5.0 or any other latest version after 5.5.0.
For details to download CCS refer to http://www.ti.com/tool/ccstudio-msp430.

2. Download TIDA-00386Firmware Project files from reference design webpage.

Hardware Set-up:

e To get the remote key-codes, do not apply main ac power to the board. Connector J2 on board provides 4-pin JTAG
interface for SPI-BY-WIRE Programming. It has pin for 3.3V and any utility which provides SPI-Programming
support, should be able to provide 3.3V to on-board devices, MSP430G2201 and IR senor TSOP31338.

Steps to change remote key codes:

1. Launch code-composer studio. Select Import Project, Browse to the directory containing the firmware on pop-up
window. Check the CCS project found and click on Finish button. You may choose to copy the project into

workspace.
- i e —— ———————— —
¥ CCS Edit - TI Resource Explorer - Code Composer Studio — '= 2 |
File Edit View MNavigate Project Run Scripts Window Help
o- e = (E cosea)
() I Resource Explorer &2 =&
&
= [=]
B _ ¥ Import CCS Eclipse Projects S A -
- [ . A Fa s
Peckages: [Welcome <] Devices: [All Topics: [All — - - — e =
| | Select Existing CCS Eclipse Project 1 .
Address: Select a directory te search for existing CCS Eclipse projects. M
<A
Welcome to Code Compd ... oo
You can bring this page up at any time by selecting Welcol
) Select archive file: Browse...
" Highligh Discovered projects:
& / New Project : £ TIDA-00386 IR Remote Code [D:\TIDA-00386-Firmware\TIDA-| [ Select All
+ Trace Analya)
" Deselect All
* ULP Advisor]| e
oé + System Anallj| ™ o
s GUI Compo
Examples
+ Resource EXll ) copy projects into workspace
+ Welcome to )|
[7] Automatically import referenced projects
[t Y Import an existing project into
A : Select this option to use projectf | Open the Resource Explorer and browse available example projects...
[~ Import Project )| /o ;o of Code Composer st
project that was provided by anj
L7 JEEe @
™
@ Web Resources
lid Licensed & [
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Build the project, by first left clicking the project Title and then clicking the build button as shown below. Close Tl
resource explorer window.

File Edt View Navigste Project Run Scripts Window Help
- R D%~ 91w e~ i ([ ccsd)
[ Project Explorer &3 B % 7 7 O/ Tl Resource Beplorer 52 |

» i TIDA-00386 IR Remote Code [Active - Debu

Packages: [Welcome - Devices: [All Topics: [All @' S
Address:

Welcome to Code Composer Studio v5 1

You can bring this page up at any time by selecting Welcome from the Help menu

. < Highlights
New Project
Resource Explorer
System Analyzer
Trace Analyzer

ULP Advisor

GUI Composer
Welcome to Grace 2

I

Examples

O
<
R

. Tutorial Videos
Import Project

Getting Started with
CodgiComposenstudio

Support

=
[Z] Problems 2 v =a
0 items
Deseription ° Resource Path Location Type

« [ »

[} Licensed 3 TIDA-00386 IR Remote Code

Download the code by clicking Debug button. In case ULP advisor window appears, click Proceed. You may choose
to select do not show again message option to avoid its appearance for future launches.

File Edit View Navigate Project Run Scripts Window Help

4 Re(B-NFv il iwErd~ 5B
[t Project Explorer 3 | Bg =0 =
» 15 TIDA-00386 IR Remote Code [Active - Debu
¥4 ULP Advisor™ ==
The Ultra-Low-Power Advisor™ (ULP Advisor™) checks for ultra-low power best practices.
You have remarks in you project, which you could use to improve power consumption in your project.
Proceed with launch? Cancel to review advice in the Problems View, grouped under the Infos category.
Checking is enabled by default. Advi jthin the jew wi the Infos category.
To change default ULP Advisor™ settings, go to Project > Properties > Build > MSP430 Compiler > ULP Advisor™
For ULP Advisor™ rule detals,vist hitp://www.ti.com/ulpadvisor.
For option details, go to Help > Help Contents > MSP430 Optimizing C/C++ Compiler User Guide
[71Do not show this message again
) Console 2 & ¢ (B) B 6B Gx| 2 B v 19~ = O|[[2 problems 52 | § Advice 7 = m]
CDT Build Console [TIDA-00386 IR Remote Code] 0items
|| Description = Resource Path Location Type
==+ Build of configuration Debug for project TIDA-80386 IR Remote Code ****
"C:\\ti\\ccsvs\\utils\\bin\\gnake" -k all
gmake: Nothing to be done for “all’
wees Build Finished ****
T =l & = = ; 0
Licensed 5 TIDA-00386 IR Remote Code. Launching TIDA-00386 L.e Code: (53%) [ &
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Upon successful downloading the code, following window appears. Match the console message and click resume.

&% ¢S Debug - TIDA- Remote tudi [E=iof==]

File Edit View Project Tools Run Scripts Window Help

e~ #-Bvs-» &5 P CCsbebig) ¢

8|22 @ | @ 5| & 7 7 O|[er Varisbles |47 Expressions it Registers %o Breakpoints 1 | [REE T RN &~ =0

4 9 TIDA-00386 IR Remote Code [Code Composer Studio - Device 03 s Identity Name Condition Count Action

4 (/P TIMSP430 USBL/MSP430 (Suspended - HW Breakpoint)
main() at main.c:129 0xFA28
_c_int00_noexit() at boot.c:L82 0+FAF6 (the entry point was reached)

[E mainc £2 \ [£] main{ at D:\TIDA-00386-Firmware\ TIDA-00386 IR Remote Code\Debug/./main.c:129 0xfa28 - o
122 } -
123 1
124
125}

126
127 void main(void)
128 {

+ 129 WDTCTL = WDTPW + WOTHOLD; // Stop watchdog timer

13 Init_clock();

131

132 PIDIR |=

133 P10UT |= BIT7; 1/ P Output E

134

135

136 /A//11011400111/11#P1.3 pulled high and configured for Hi/lo interrupt edge///////11/

137 REN|=BIT3; /Push button pulled high

138

139

140 // P2.6 interrupt enabled

141 /7 P2.6 Hiflo edge

182 PLIFG &= ~BIT3; /7 P2.6 IFG cleared

B O T e e oo

144 i
g r

W HBl#B-ri-=0
A-00386 IR Remote Code

MSP438: Loading complete. Code Size - Tewt: 088 bytes Data: 14 bytes. =

Licensed Wiitable Smart Insert 129:1

11/5/2014

Insert breakpoint by right clicking at line 112, (right side of 112) and then selecting breakpoint option from pop-up
window.

% CCS Debug - TIDA-00386 IR Remote Stu = | |

File Edit View Project Tools Run Scripts Window Help

(i Hr @r@E-DRer £ [ [ €CS Debug | B¢
%5 Debug £ | %0 0 @ | 3. A ~ & | @ 7 = O|[9- Veriables 47 Expressions | Uit Registers | % Brekpoints £ | FEEET RN
4 % TIDA-00386 IR Remote Code [Cade Composer Studic - Device Debugging] Identity Name Condition Count Action

@ TIMSP430 USBL/MSP430 (Running)

M [©] main() at DATIDA-00386-Firmware\ TIDA-00386 IR Remote Code\Debug/../main.c:129 0xfa28 =0
03 * TASSEL_2 -- SMCLK a
99 * 1D -- Divider - /1
100 * MC_1 -- Up Mode
101 -

102 TACTL = TASSEL_2 + ID_8 + MC_1;
103}

105 void Process_Remote_Code(void)
106

if (Flag@switch_pressed) //switch_pressed is like an interrupt flag E
Flagd=~(Switch_pressed); //Disable interrupt flag like you would disable a flag in an ISR
Last_switch=Switch; //store Switch( I think this is the 32 bit data obtained) in Last Switch and Prgy Switch
|rCart ramat, B tha Ciart Damaba o £12¢
Breakpoint (Code Composer Studio) » Breakpoint
Open Declaation = Hardware Breakpoint
Watchpoint
Cut CtrieX
Copy Cul+C
Paste CuleV -
v
= Declarations > GeE--o0
C -
© References » w 6B | o |
MDA | search v
nspa3| carch Text es Data: 14 bytes. =
=] Runtoline CulR
3. Move ToLine
%Y Add Watch Expression..
Preferences..
0 B Licensed Writable Smart Insert 112:1
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12

7.

Point your remote to IR sensor and press increment key. The code should come to halt at line 112. Move the cursor
to variable “ Switch” on line 110, a pop window will appear as shown below. Note down the Hex code, this is code for
increment key of your remote.

% CCS Debug - TIDA Remote e 5 o
File Edit View Project Tools Run Scripts Window Help
(i #HriB@ra-Doex £~ [ [¥5 CCSDebug | B ¢~
5 Debug 22 | T IR s M:VanablesG;-fapres;m;‘wr{egmr;w § | REPHAN|EEE =0
4 7 TIDA-00336 IR Remote Code [Code Composer Studio - Device Debugging] Identity Name Condition Count Action
4 §® TIMSP430 USB1/MSP430 (Suspended - HW Breakpaint) % meinc, ne 12 (roc Breskpoint o) e
Process Remote_Code() at main.ci112 0xF920
main{) at main.ci155 0FASC
in00_noexit() at boot.c:183 0xFAFG (the entry point was reached)
main() at D:\TIDA-00386-Firmuare\ TIDA-00386 IR Remote Code\Debug/../main.c:129 Oxfa2B =8
o8 * TASSEL_2 -- SMCLK x
99 * ID_8 -- Divider - /1
106 * MC1 -- Up Mode
101 *
102 TACTL = TASSEL 2 + ID_8 + MC_1;
103}
104
"105void Process_Remote_Code(void)
106 {
107 if (FlagiSwitch_pressed) //Switch_pressed is like an interrupt flag B
108 {
109 Flagt=~(Suitch_pressed); //Disable interrupt flag like you weuld disable a flag in an ISR
116 Last_Switch=Switch; //5tore Switch( T think this is the 32 bit data obtained) in Last Switch and Prey Switch
111
112 Flag|=(Starg BPression Type Value
113 if (Last_swi]  (9- Switch unsigned long 16734375
114 i
115 Set_Outp
116 if (Set
117 1
118 clse if (Las —
119 Name : Slvﬂtfh -
H120 Set Outp L

m

. G

Lt | Tecinal:iersasss

B Console % Octal:@77654247 Bl B~r5-r=0
TIDA-00386 R Remote Code | ¢ Ll et 12 :

MSPa30: Loading complete. COWE STZE = TEXET UU5 ByEes DFtaT TA ByTes- z

8% ®  Licensed

Again resume the code as mentioned in step 4. Point the remote to IR sensor and press decrement key. Repeat the
process as explained in previous step.

¥ €CS Debug - TIDA:
File Edt View Project Tools Run Scripts Window Help

wilhd BB -NDRDE S 5 [B5 CCSDebug | [ ¢~
S @22 D R & @ T = 0|0 Variables | & Expressions |l Registers| % Breakpoints 53 AEE T ERN &~ =0
4 ¥ TIDA-00386 IR Remote Code [Code Composer Studio - Device Debugging] Identity Name Condition Count Action
4 TIMSP430 USB1/MSP430 (Suspended - HW Breskpoint} [7] 4, main.c, line112 (Proc Breakpoint 0(0) Remain Halted
rocess_Remote_Code() at main.c112 0xF320 |
main() at main.c:155 0xFAGC
int0_noexit() at boot.c183 0xFAFG (the entry point was reached)
main.c s@} ain() at D:\TIDA-00386-Firmware\ TIDA-00386 IR Remote Code\Debug/../main.c:129 0xfa28 =8
* TASSEL 2 -- SMCLK -
= ID_@ -- Divider - /1
= MC_1 -- Up Mode
=/
TACTL = TASSEL_2 + ID_8 + MC_1;
105 void Process Remote Code(void)
if (FlagdSwitch pressed) J4Switch pressed is like an interrupt flag El
{
Flaglen(Switch pressed); J/Disable interrupt flag like you would disable a flag in an ISR
Last_Switch=Switch; /istore Switch( I think this is the 32 bit data obtained) in Last Switch and Prey Switch
Flag|=(stare BPression Type Value
if (Last_swi] s Switch unsigned long 16738455
{
Set_Outp
if (Set |
b N
else 3F (183 ane & switen .
Default:16738455 i
: set Outp 3 ;
— Decimal:16738455
B Console 2t Octal:077664227 i EupE[ M E-[9-=0
TIDA-00386 IR Remote Code | ¢ oo = 5
MSP430: Loading complete. UGdE SIZE = TEXEr UU8 bytes Datar T& Bytes: A
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8. Repeat the step 6 and 7 two to three times, and make sure every time both key codes are same. Upon successful
repetition, go to line 112 and disable the break-point by right-click exactly at break-point (left side of 112) and
selecting “toggle breakpoint “option from pop-up window and terminate the debug launch by clicking red button next
to resume.

' CCS Debug - TIDA-00386 IR Remote. in.c - Studio oo

File Edit View Project Tools Run Scripts Window Help

i~ D~ i~ 5 (%5 CCS Debug | B ¢
s Debug 52 | Lo B3 22 5 e @ &% 7 7 O Varables |47 Bxpressions | B Registers| %o Breakpoints 1% | - R%BENBEST "D
% TIDA-00386 IR Remote Code [Code Composer Studio - Device Debugging] Identity Name Condition Count Action
o TIMSP430 USBL/MSP430 (Suspended - HW Breakpoint) % main.c,line 112 (Proc Breakpoint 0 e s
= Process_Remote_Code() at main.c:112 03F920
= main() at main,c:155 04FAGC
= _c_int00_noexit() at boot.c:183 0xFAF6 (the entry point was reached)

[c) mainc &3 } [€] main() at DATIDA-00386- Firmware\ TIDA-00386 IR Remote Code\Debug/ ./main.ci129 0xfa28 =8
98 * TASSEL_2 -- SMCLK a
as = 100 - Divider - /1

100 * MC_1 -- Up Mode
101 =
102 TACTL = TASSEL 2 + ID_@ + MC_1;
183}
184
195 void Process Remote Code(void)
106 {
107 if (Flag&Switch_pressed) f/switch_pressed is like an interrupt flag
108 {
109 Flagi=~(Switch_pressed); //Disable interrupt flag like you would disable a flag in an ISR
110 Last_Switch=Switch; //Store Switch( I think this is the 32 bit data obtained) in Last Switch and Prey Switch
111
E
Breakpoint (Code Composer Studic) v
Toggle Breakpoint Ctrl+ Shift+B
Disable Breakpaint Shift+Double Click
Breakpoint Properties.
Breakpoint Types »
Go to Anntation Ctrls1 ¥
5 #E-~r5-—0
Add Bookmark... Ge |t @- 3
Add Task.
ata: 14 bytes. -
V' Show Quick Diff Crl+ Shift+Q
v Show Line Numbers
Folding »
Preferences...
g% @ Licensed Writable Smartlnsert | 112:76

9. Go to main.C and change the key-codes at line 64 and 65. Re-flash the new code as explained in step 3 & 4. New
code is ready to use for speed control with your remote.

File Edit View Nevigate Project Run Scripts Window Help
- [ S D B %5 CCS Debug [0

[ Project Explorer 23\ 5% ¥ % O||[&mainc 23\ =8
» 15 TIDA-00386 IR Remote Code [Active - Debu| -~ Unsigned char Output_Period = 8, Set_Output =5; P
se

51#define BTL ase

52 #define BTH 650

53

54 #idefine UARTENABLE

55

56 unsigned char Flag; //this is a big flag which checks about the below
57 #define Switch_pressed EITe
58 #define Start_remots_process  BITL
59 #define Start_bit flag BIT2
60 #define Resend_bit_flag BIT3
61 #define valid_start_high BITZ

I

64 #define UP_Key OxBOFFSBA7 #{ Increment Key-code
65 #define DOWN_Key OxBOFF6897 4 Decrement Key-code
67
65 void Init_clock(void)
76 BCSCTL2 = SELM @ + DIVM_® + DIVS_0;
72 if (CALBC1_IMWI |= oxFF)

{

78 /* Follow recommended flow. First, clear all DCOx and MODx bits. Then
75 * apply new RSELx values. Finally, apply new DCOx and MODx bit values.
*/

77 DCOCTL = @xee;
78 BCSCTLL = CALBCL_1MHZ; /% Set DCO to 1MHz */
79 DCOCTL = CALDCO_1MHZ;
80 ¥
82 BCSCTLL |= XT20FF + DIVA_@; -
B T T - B »
& Console 37 4 B~ 04~ = 0| problems 23\ @ Adwce‘ <=8

No consoles to display at this time. 0 items
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